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NEW QUESTION 1

- (Exam Topic 1)

You need to roll back the mobile app to an earlier version.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Regquirement Action

Identify the currently published version and view version notes. | [l

\View the session details page for the app in Power Apps Studio.
[View environment details for the app in the Power Admin portal,
|Wiew details for the app in the Power Apps Maker portal.

Revert to an earlier version of the app. [ v

[Select Restore on the previous version of the app.
|Export the previous version of the app and import as a new version.
|Delete versions of the app until the desired version is the most recent.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: View the sessions details page for the app in Power Apps Studio

Use PowerApps Studio, select the App, and choose and you will be directed to the app’s Versions tab in PowerApps portal. There should be one version marked

Live.

Detalls - Share - Versions . Settings

T L N e e T T, 7 o
d Wers k i #31

f
VERSION MODIFIED MODIFIED BY POWERAPPS RELEASE / ) PUBLISHED COMMENT

1 6/7/2017 5:01:43 AM Karthik Bharathy 20659 [ Live ]

Box 2: Select Restore on the previous version of the app. Restore an app from your account

> Open powerapps.com, and then click or tap Apps in the left navigation bar.

> Near the right edge, click or tap the info icon for the app that you want to restore.

> Click or tap the Versions tab, and then click or tap Restore for the version that you want to restore.

Details - Share . Versions « Settings -«  Analytics (preview)

FowerApps keeps 3 version histony of your 2pps
VERSION MODIFIED MODIFIED BY POWERAPPS RELEASE @ PUBLISHED COMMENT
2 8/20/2018 2:24:29 PM  Firstname Lastname 3.18081.19 Live

1 7/9/2018 10:55:48 AM  Firstname LastName  3.18071.36 Delete

Reference:
https://powerapps.microsoft.com/sk-sk/blog/saveandpublish/ https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/restore-an-app

NEW QUESTION 2

- (Exam Topic 3)

Each maker at a company has a separate Common Data Service environment. You are customizing a canvas app. You create two new entities in your
environment.

You are leaving for a vacation. Another maker will continue customizing the app in your absence.

You need to transfer the work to the other maker and ensure that you can work on the updated app when you return from your vacation.

What should you export?

A. ununmanaged solution that includes all customizations
B. the default solution

C. a managed solution that includes all customizations

D. the app

Answer: A

Explanation:

Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.

Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1SV/Managed-vs-Unmanaged/td-p/495685
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NEW QUESTION 3

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating a canvas app that displays a list of accounts.

Users must be able to select an account and view details for the account. The app must include a feature that brings the user back to the list of accounts.
You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the screen. You set the data source of Gallery Accounts to
Accounts and add another blank screen named Screen_AccountDetalil.

You need to complete the app. Solution:

> Add an edit form to Screen_AccountDetail and set the Default Mode of the form to View.

> Set the OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail).

> Set the data source of the form to Accounts.

> Set the Item property of the form to Selected.

> Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate(Screen_Accounts).
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation:

View, edit, or create an item, save the contents, and reset the controls in an Edit form control. FormMode.View: The form is populated with an existing record but
the user cannot modify the values of the

fields.

This function is often invoked from the OnSelect formula of a Button or Image control. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-form

NEW QUESTION 4
- (Exam Topic 3)
A company uses Power Automate and Power Apps to streamline business processes. You need to use Al Builder to analyze customer reviews of the company’s

products.
In which order should you perform the actions? To answer, move all actions from the list of actions to the answer area and arrange them in the correct order.
Action Answer Area

Publish the model.
Connect data to the model,
Train the model.

Use the model in a Power Automate flow.

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Step 1: Connect data to the model.
First create an Al Builder form processing model for the customer reviews you want to process.
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Step 2: Train the model. Step 3: Publish the model.

Step 4: Use the model in a Power Automate flow.

Once you train and publish the model, create a solution-aware flow in Power Automate. Reference:
https://powerapps.microsoft.com/en-us/blog/introducing-simplified-ai-builder-experience-in-power-automate/

NEW QUESTION 5

- (Exam Topic 3)

A company uses data loss prevention (DLP) policies. You have a Power Automate flow that posts Twitter mentions into a Microsoft SharePoint list.
You are not able to activate the flow. You need to troubleshoot the issue.

What are two possible reasons why you cannot activate the flow? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. You are not assigned the Power Platform Admin role.

B. You placed all connectors into the Business group within the DLP policy.

C. You placed all connectors into the Non-Business group within the DLP policy.
D. You are not assigned the Environment Admin role.

Answer: BD
Explanation:
D: DLP policies are created in the Power Platform admin center. They affect Power Platform canvas apps and Power Automate flows. To create a DLP policy, you

need to be a tenant admin or have the Environment Admin role.
B: This table describes how the DLP policy you created affects data connections in apps and flows.
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Connector SharePoint
matrix (Business)
SharePoint Allowed
(Business)

Salesforce Allowed
(Business)

Outlook.com Denied
(Non-

Business)

Facehook Denied
(Blocked)

Twitter
(Blocked)

Note: Any connector that resides in the Non-Business data group—such as Outlook.com—won't share data with apps and flows by using SharePoint or Salesforce
connectors. Facebook and Twitter connectors are altogether blocked from being used in any app or flow in hon-test environments such as production or default

environments.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/wp-data-loss-prevention

NEW QUESTION 6
- (Exam Topic 3)

You are designing a canvas app that will be used by all users including users who have vision impairments. Which outcome is achieved by each action? To

answer, drag the appropriate outcomes to the correct actions.

Each outcome may be used once, more than once, or not at all. You may need to drag the split bar between
panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Outcomes Answer Area
Mot visible to any users Action Outcome
Set the values for the X and Y properties of a control to
Wisible to sighted users only move the control off-screen,
= Set the Color and other related properties of a control to
Visible to screen-reader users only transparent.
Sat the Height and Width properties of a control to 1.

Wisible to both sighted and screen-reader users

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/sv-se/powerapps/maker/canvas-apps/accessible-apps

NEW QUESTION 7

- (Exam Topic 3)

You are an app maker. You are creating a canvas app. You do not have access to Power BI.

You need to add charts to the app.

Which three chart types can you add directly to the canvas app? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. pie

B. area
C. funnel
D. column
E. line

Answer: ADE

Explanation:

You can use line charts, pie charts, and bar charts to display your data in a canvas app. Add a bar chart to display your data:

* 1. On the Home tab, add a screen.
* 2. On the Insert tab, select Charts, and then select Column Chart. Reference:
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https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/use-line-pie-bar-chart

NEW QUESTION 8

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.

Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.

You need to ensure that users can scan packing slip information into the form.

Proposed solution: Use a Category classification model. Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:
A Category classification model categorizes text by its meaning. Reference:
https://knowledgefrommanish.com/powerplatform/ai-builder-entity-extraction-ai-model/

NEW QUESTION 9

- (Exam Topic 3)

You use a Microsoft SharePoint list to record information about customers.

You must perform a series of actions only when a new item is added to a SharePoint list. You need to configure a Power Automate flow.
Which trigger should you use?

A. When an item is created

B. When an item is created or modified
C. When afile is created (properties only)
D. For a selected item

Answer: A

Explanation:

Trigger - When an item is created Triggers when an item is created.

MS Flow will trigger when an item is created in the list. It will return all list item properties which can be used in the Flow.
Reference:

https://www.c-sharpcorner.com/article/sharepoint-based-triggers-in-ms-flow-part-2/

NEW QUESTION 10

- (Exam Topic 3)

You create multiple apps as part of an unmanaged solution. You need to move the apps to another environment.

You need to pick the appropriate solution type for each requirement.

Which types of solutions should you create? To answer, drag the appropriate solution types to the correct requirements. Each solution type may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Solution types Answer Area
i Managed Requirement Solution type
i Edit existing components of the solution.
| Unmanaged
Add new components to the solution.
Export the solution.
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Box 1: Unmanaged

Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.

Box 2: Unmanaged

Box 3: Managed

Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.

Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1ISV/Managed-vs-Unmanaged/td-p/495685
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NEW QUESTION 10

- (Exam Topic 3)

You create a custom field on the Account entity.

Members of TeamA must have full access to the field. Members of TeamB must have no access to the field. You need to configure security.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actions Answer Area

Add TeamA to the field security profile.

Create a field security profile and set all the
permissions for the custom attribute to Yes.

Add TeamB to the field security profile.

Create a field security profile and set all the
permissions for the custom attribute to Ne.

Enable field-level security for the field.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Enable field security for the field

Step 2: Create a field security profile and set all the permissions for the custom attribute to Yes. Step 3: Add TeamA to the field security profile.

Note: Field-level security is available for the default fields on most out-of-box entities, custom fields, and custom fields on custom entities. Field-level security is
managed by the security profiles. To implement field-level security, a system administrator performs the following tasks.

> Enable field security on one or more fields for a given entity.
> Associate one more existing security profiles, or create one or more new security profiles to grant the appropriate access to specific users or teams.

NEW QUESTION 13

- (Exam Topic 3)

You create a canvas app for technicians at a computer store. You assign technicians cases to work on. The technicians update cases at the end of customer site
visit.

The manager wants the technicians to sell warranties to the customers. If a customer agrees to purchase a warranty, technicians use the canvas app to
immediately alert the sales team, and then the technician records details about the warranty into the app.

You need to create a flow to alert the sales team. Which type of trigger should you use?

A. Flow button for mobile
B. Power Apps

C. Office 365 Outlook

D. Common Data Service

Answer: A

Explanation:

Create a button flow to run routine tasks by simply tapping a button. Customize your flow by allowing the user to provide specific details that will be used when the
flow runs.

Note: There are many repetitive tasks that we all wish we could run with just a tap of a button. For example, you may need to quickly email your team to remind
them to join the daily team sync, or you may want to start a new Visual Studio Codespaces build of your code base after you've been notified that there are no
more checkins planned for the day. Button flows allow you to accomplish these and many other tasks simply by tapping a button on your mobile device.
Reference:

https://docs.microsoft.com/en-us/power-automate/button-flow-with-user-input-tokens

NEW QUESTION 15

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.

Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.

You need to ensure that users can scan packing slip information into the form. Proposed solution: Use an Entity Extraction model.

Does the solution meet the goal?

A. Yes
B. No

Answer: A
Explanation:
Al Builder entity extraction models recognize specific data in the text that you target based on your business needs.

The model identifies key elements in the text and then classifies them into predefined categories. This can help you transform unstructured data into structured
data that's machine-readable. You can then apply processing to retrieve information, extract facts, and answer questions.
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Note: Create a canvas app and add the text recognizer Al Builder component to your screen. This component takes a photo or loads an image from the local
device, and then processes it to detect and extract text based on the text recognition prebuilt model. If it detects text in the image, the component outputs the text
and identifies the instances by showing a rectangle for each instance in the image.

Reference:

https://knowledgefrommanish.com/powerplatform/ai-builder-entity-extraction-ai-model/ https://docs.microsoft.com/en-us/ai-builder/prebuilt-text-recognizer-
component-in-powerapps

NEW QUESTION 17

- (Exam Topic 3)

You create a model-driven app for a company. The app will be used to manage events that the company organizes.

The Events entity ownership type is set to User or team. Members of the marketing team are assigned the MarketingTeam security role. All privileges for the role
are set to User access.

All employees must be able to view event records. Only members of the marketing team are permitted to create or edit event records. You create a role named
OtherEmployees.

You need to configure the MarketingTeam and OtherEmployees security roles.

Which three actions should you perform? Each correct selection presents a part of the solution.

NOTE: Each correct selection is worth one point.

A. Set the access level for the OtherEmployees security role to Organization for the Read permission.

B. Set the access level for the MarketingTeam security role to Organization for the Read permission.

C. Set the access level for the OtherEmployees security role to None Selected for the Read permission.

D. Set the access level for the MarketingTeam security role to None Selected for the Read permission.

E. Set the access level for the MarketingTeam security role to None Selected for the Create and White permission.
F. Set the access level for the OtherEmployees security role to None Selected for the Create and Write permission.

Answer: ABE

NEW QUESTION 20
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NEW QUESTION 1

- (Exam Topic 1)

You need to roll back the mobile app to an earlier version.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
Answer Area

Regquirement Action

Identify the currently published version and view version notes. | [l

\View the session details page for the app in Power Apps Studio.
[View environment details for the app in the Power Admin portal,
|Wiew details for the app in the Power Apps Maker portal.

Revert to an earlier version of the app. [ v

[Select Restore on the previous version of the app.
|Export the previous version of the app and import as a new version.
|Delete versions of the app until the desired version is the most recent.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: View the sessions details page for the app in Power Apps Studio

Use PowerApps Studio, select the App, and choose and you will be directed to the app’s Versions tab in PowerApps portal. There should be one version marked

Live.

Detalls - Share - Versions . Settings

T L N e e T T, 7 o
d Wers k i #31

f
VERSION MODIFIED MODIFIED BY POWERAPPS RELEASE / ) PUBLISHED COMMENT

1 6/7/2017 5:01:43 AM Karthik Bharathy 20659 [ Live ]

Box 2: Select Restore on the previous version of the app. Restore an app from your account

> Open powerapps.com, and then click or tap Apps in the left navigation bar.

> Near the right edge, click or tap the info icon for the app that you want to restore.

> Click or tap the Versions tab, and then click or tap Restore for the version that you want to restore.

Details - Share . Versions « Settings -«  Analytics (preview)

FowerApps keeps 3 version histony of your 2pps
VERSION MODIFIED MODIFIED BY POWERAPPS RELEASE @ PUBLISHED COMMENT
2 8/20/2018 2:24:29 PM  Firstname Lastname 3.18081.19 Live

1 7/9/2018 10:55:48 AM  Firstname LastName  3.18071.36 Delete

Reference:
https://powerapps.microsoft.com/sk-sk/blog/saveandpublish/ https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/restore-an-app

NEW QUESTION 2

- (Exam Topic 3)

Each maker at a company has a separate Common Data Service environment. You are customizing a canvas app. You create two new entities in your
environment.

You are leaving for a vacation. Another maker will continue customizing the app in your absence.

You need to transfer the work to the other maker and ensure that you can work on the updated app when you return from your vacation.

What should you export?

A. ununmanaged solution that includes all customizations
B. the default solution

C. a managed solution that includes all customizations

D. the app

Answer: A

Explanation:

Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.

Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1SV/Managed-vs-Unmanaged/td-p/495685
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NEW QUESTION 3

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You are creating a canvas app that displays a list of accounts.

Users must be able to select an account and view details for the account. The app must include a feature that brings the user back to the list of accounts.
You add a blank screen named Screen_Accounts and add a gallery named Gallery_Accounts to the screen. You set the data source of Gallery Accounts to
Accounts and add another blank screen named Screen_AccountDetalil.

You need to complete the app. Solution:

> Add an edit form to Screen_AccountDetail and set the Default Mode of the form to View.

> Set the OnSelect property of Gallery_Accounts to Navigate(Screen_AccountDetail).

> Set the data source of the form to Accounts.

> Set the Item property of the form to Selected.

> Add a back icon on Screen_AccountDetail and set its OnSelect property to Navigate(Screen_Accounts).
Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation:

View, edit, or create an item, save the contents, and reset the controls in an Edit form control. FormMode.View: The form is populated with an existing record but
the user cannot modify the values of the

fields.

This function is often invoked from the OnSelect formula of a Button or Image control. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-form

NEW QUESTION 4
- (Exam Topic 3)
A company uses Power Automate and Power Apps to streamline business processes. You need to use Al Builder to analyze customer reviews of the company’s

products.
In which order should you perform the actions? To answer, move all actions from the list of actions to the answer area and arrange them in the correct order.
Action Answer Area

Publish the model.
Connect data to the model,
Train the model.

Use the model in a Power Automate flow.

A. Mastered
B. Not Mastered

Answer: A
Explanation:

Step 1: Connect data to the model.
First create an Al Builder form processing model for the customer reviews you want to process.
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Step 2: Train the model. Step 3: Publish the model.

Step 4: Use the model in a Power Automate flow.

Once you train and publish the model, create a solution-aware flow in Power Automate. Reference:
https://powerapps.microsoft.com/en-us/blog/introducing-simplified-ai-builder-experience-in-power-automate/

NEW QUESTION 5

- (Exam Topic 3)

A company uses data loss prevention (DLP) policies. You have a Power Automate flow that posts Twitter mentions into a Microsoft SharePoint list.
You are not able to activate the flow. You need to troubleshoot the issue.

What are two possible reasons why you cannot activate the flow? Each correct answer presents a complete solution.

NOTE: Each correct selection is worth one point.

A. You are not assigned the Power Platform Admin role.

B. You placed all connectors into the Business group within the DLP policy.

C. You placed all connectors into the Non-Business group within the DLP policy.
D. You are not assigned the Environment Admin role.

Answer: BD
Explanation:
D: DLP policies are created in the Power Platform admin center. They affect Power Platform canvas apps and Power Automate flows. To create a DLP policy, you

need to be a tenant admin or have the Environment Admin role.
B: This table describes how the DLP policy you created affects data connections in apps and flows.
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Connector SharePoint
matrix (Business)
SharePoint Allowed
(Business)

Salesforce Allowed
(Business)

Outlook.com Denied
(Non-

Business)

Facehook Denied
(Blocked)

Twitter
(Blocked)

Note: Any connector that resides in the Non-Business data group—such as Outlook.com—won't share data with apps and flows by using SharePoint or Salesforce
connectors. Facebook and Twitter connectors are altogether blocked from being used in any app or flow in hon-test environments such as production or default

environments.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/wp-data-loss-prevention

NEW QUESTION 6
- (Exam Topic 3)

You are designing a canvas app that will be used by all users including users who have vision impairments. Which outcome is achieved by each action? To

answer, drag the appropriate outcomes to the correct actions.

Each outcome may be used once, more than once, or not at all. You may need to drag the split bar between
panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Outcomes Answer Area
Mot visible to any users Action Outcome
Set the values for the X and Y properties of a control to
Wisible to sighted users only move the control off-screen,
= Set the Color and other related properties of a control to
Visible to screen-reader users only transparent.
Sat the Height and Width properties of a control to 1.

Wisible to both sighted and screen-reader users

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/sv-se/powerapps/maker/canvas-apps/accessible-apps

NEW QUESTION 7

- (Exam Topic 3)

You are an app maker. You are creating a canvas app. You do not have access to Power BI.

You need to add charts to the app.

Which three chart types can you add directly to the canvas app? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. pie

B. area
C. funnel
D. column
E. line

Answer: ADE

Explanation:

You can use line charts, pie charts, and bar charts to display your data in a canvas app. Add a bar chart to display your data:

* 1. On the Home tab, add a screen.
* 2. On the Insert tab, select Charts, and then select Column Chart. Reference:
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https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/use-line-pie-bar-chart

NEW QUESTION 8

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.

Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.

You need to ensure that users can scan packing slip information into the form.

Proposed solution: Use a Category classification model. Does the solution meet the goal?

A. Yes
B. No

Answer: B

Explanation:
A Category classification model categorizes text by its meaning. Reference:
https://knowledgefrommanish.com/powerplatform/ai-builder-entity-extraction-ai-model/

NEW QUESTION 9

- (Exam Topic 3)

You use a Microsoft SharePoint list to record information about customers.

You must perform a series of actions only when a new item is added to a SharePoint list. You need to configure a Power Automate flow.
Which trigger should you use?

A. When an item is created

B. When an item is created or modified
C. When afile is created (properties only)
D. For a selected item

Answer: A

Explanation:

Trigger - When an item is created Triggers when an item is created.

MS Flow will trigger when an item is created in the list. It will return all list item properties which can be used in the Flow.
Reference:

https://www.c-sharpcorner.com/article/sharepoint-based-triggers-in-ms-flow-part-2/

NEW QUESTION 10

- (Exam Topic 3)

You create multiple apps as part of an unmanaged solution. You need to move the apps to another environment.

You need to pick the appropriate solution type for each requirement.

Which types of solutions should you create? To answer, drag the appropriate solution types to the correct requirements. Each solution type may be used once,
more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.

Solution types Answer Area
i Managed Requirement Solution type
i Edit existing components of the solution.
| Unmanaged
Add new components to the solution.
Export the solution.
A. Mastered

B. Not Mastered
Answer: A

Explanation:

Box 1: Unmanaged

Unmanaged Solution: The beginning state of solution is the unmanaged solution state. During this phase, you can add, edit, update, remove, delete, and test any
of the components of the solution.

Box 2: Unmanaged

Box 3: Managed

Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.

Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1ISV/Managed-vs-Unmanaged/td-p/495685
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NEW QUESTION 10

- (Exam Topic 3)

You create a custom field on the Account entity.

Members of TeamA must have full access to the field. Members of TeamB must have no access to the field. You need to configure security.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

Actions Answer Area

Add TeamA to the field security profile.

Create a field security profile and set all the
permissions for the custom attribute to Yes.

Add TeamB to the field security profile.

Create a field security profile and set all the
permissions for the custom attribute to Ne.

Enable field-level security for the field.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Enable field security for the field

Step 2: Create a field security profile and set all the permissions for the custom attribute to Yes. Step 3: Add TeamA to the field security profile.

Note: Field-level security is available for the default fields on most out-of-box entities, custom fields, and custom fields on custom entities. Field-level security is
managed by the security profiles. To implement field-level security, a system administrator performs the following tasks.

> Enable field security on one or more fields for a given entity.
> Associate one more existing security profiles, or create one or more new security profiles to grant the appropriate access to specific users or teams.

NEW QUESTION 13

- (Exam Topic 3)

You create a canvas app for technicians at a computer store. You assign technicians cases to work on. The technicians update cases at the end of customer site
visit.

The manager wants the technicians to sell warranties to the customers. If a customer agrees to purchase a warranty, technicians use the canvas app to
immediately alert the sales team, and then the technician records details about the warranty into the app.

You need to create a flow to alert the sales team. Which type of trigger should you use?

A. Flow button for mobile
B. Power Apps

C. Office 365 Outlook

D. Common Data Service

Answer: A

Explanation:

Create a button flow to run routine tasks by simply tapping a button. Customize your flow by allowing the user to provide specific details that will be used when the
flow runs.

Note: There are many repetitive tasks that we all wish we could run with just a tap of a button. For example, you may need to quickly email your team to remind
them to join the daily team sync, or you may want to start a new Visual Studio Codespaces build of your code base after you've been notified that there are no
more checkins planned for the day. Button flows allow you to accomplish these and many other tasks simply by tapping a button on your mobile device.
Reference:

https://docs.microsoft.com/en-us/power-automate/button-flow-with-user-input-tokens

NEW QUESTION 15

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.

Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.

You need to ensure that users can scan packing slip information into the form. Proposed solution: Use an Entity Extraction model.

Does the solution meet the goal?

A. Yes
B. No

Answer: A
Explanation:
Al Builder entity extraction models recognize specific data in the text that you target based on your business needs.

The model identifies key elements in the text and then classifies them into predefined categories. This can help you transform unstructured data into structured
data that's machine-readable. You can then apply processing to retrieve information, extract facts, and answer questions.
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Note: Create a canvas app and add the text recognizer Al Builder component to your screen. This component takes a photo or loads an image from the local
device, and then processes it to detect and extract text based on the text recognition prebuilt model. If it detects text in the image, the component outputs the text
and identifies the instances by showing a rectangle for each instance in the image.

Reference:

https://knowledgefrommanish.com/powerplatform/ai-builder-entity-extraction-ai-model/ https://docs.microsoft.com/en-us/ai-builder/prebuilt-text-recognizer-
component-in-powerapps

NEW QUESTION 17

- (Exam Topic 3)

You create a model-driven app for a company. The app will be used to manage events that the company organizes.

The Events entity ownership type is set to User or team. Members of the marketing team are assigned the MarketingTeam security role. All privileges for the role
are set to User access.

All employees must be able to view event records. Only members of the marketing team are permitted to create or edit event records. You create a role named
OtherEmployees.

You need to configure the MarketingTeam and OtherEmployees security roles.

Which three actions should you perform? Each correct selection presents a part of the solution.

NOTE: Each correct selection is worth one point.

A. Set the access level for the OtherEmployees security role to Organization for the Read permission.

B. Set the access level for the MarketingTeam security role to Organization for the Read permission.

C. Set the access level for the OtherEmployees security role to None Selected for the Read permission.

D. Set the access level for the MarketingTeam security role to None Selected for the Read permission.

E. Set the access level for the MarketingTeam security role to None Selected for the Create and White permission.
F. Set the access level for the OtherEmployees security role to None Selected for the Create and Write permission.

Answer: ABE

NEW QUESTION 20
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